
Network Interface Board

Operating Instructions

Read this manual carefully before you use this product and keep it handy for future

reference.

For safety, please follow the instructions in this manual.



Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-

tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the “Printer Reference” before using this machine. It contains im-

portant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable

for direct, indirect, special, incidental, or consequential damages as a result of handling or operating

the machine.

Note

The names of the applications do not appear in the following pages. Confirm which applications you

will be using before reading this manual.

Software Version Conventions Used in this Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh are registered trademarks of Apple Computer,

Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United

States and/or other countries.

Netscape, Netscape Navigator are registered trademarks of Netscape Communications Corporation.

Novell, NetWare, NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights in those marks.

Note

The proper names of the Windows operating systems are as follows:

• Microsoft® Windows® 95 operating system

• Microsoft® Windows® 98 operating system

• Microsoft® Windows® 2000 Professional

• Microsoft® Windows® 2000 Server

• Microsoft® Windows NT® Server operating system Version 4.0

• Microsoft® Windows NT® Workstation operating system Version 4.0

• Microsoft® Windows® Millenium edition (Windows Me)

Descriptions in this manual Application

PRINTER MANAGER FOR ADMINISTRA-
TOR

Aficio Manager for Admin

Net Vision for Admin

PRINTER MANAGER FOR CLIENT Aficio Manager for Client

Net Vision for Client
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Manuals for This Printer

The following manuals describe the operational procedures and maintenance of
this machine.

To enhance safe and efficient operation of this printer, all users should read and
follow the instructions carefully.

❖❖❖❖ Quick Installation Guide
Describes how to install the printer.

❖❖❖❖ Setup Guide  
Provides information about setting up the printer and its options. This man-
ual is provided as a printed manual, and also as a PDF file on the CD-ROM
labeled "Operating Instructions".

❖❖❖❖ Printer Reference
Provides information about using the printer and its options. This manual
provided as a PDF file on the CD-ROM labeled “Operating Instructions”.

❖❖❖❖ Network Interface Board Operating Instructions (this manual)
Provides information about setting up and using the printer in a network en-
vironment. This manual provided as a PDF file on the CD-ROM labeled “Op-
erating Instructions”.

❖❖❖❖ PostScript 3 Operating Instructions Supplement
Describes the menus and features for the PostScript 3 printer driver. This
manual provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions”.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions”.

Note

❒ There are two CD-ROMs that come with this printer. One is labeled "Operat-
ing Instructions" and the other is "Drivers and Utilities".
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

Important

If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference

This symbol indicates a reference.

[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.

Keys on the computer's keyboard.
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Introduction

This manual contains detailed instructions on configuring the printer as a net-
work printer. Read the section appropriate to your network environment for
how to configure the printer correctly.

Important

❒ The procedures written in this manual assume that you are a network administrator.
If you are not, be sure to consult your network administrator before configuration.

Reference

For more information about physically installing the Network Interface
Board and cabling, see the "Setup Guide" that comes with the printer.

For more information about configuring the Network Interface Board with
the operation panel, see the "Setup Guide" that comes with the printer.

❖❖❖❖ Features

• Support for 100BASE-TX and 10BASE-T

• The Network Interface Board is compatible with NetWare (IPX/SPX, TCP/
IP), Windows NT (TCP/IP, NetBEUI, IPP *1 ), Windows 2000 (TCP/IP, Net-
BEUI, IPP *1 ), Windows 95/98/Me (TCP/IP, NetBEUI, IPP *1 ), UNIX (TCP/
IP) and Macintosh (AppleTalk) protocols. This allows you to use the printer
in a network that uses different protocols and operating systems.

• A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

• The Network Interface Board can connect the printer to the network with-
out requiring its own power supply because the Network Interface Board
is installed inside the printer.

*1 IPP (Internet Printing Protocol) is a protocol for printing via the Internet.

NetWare (Server)

Windows NT (Server)
Windows 2000,

Windows 95/98/Me

Macintosh

         NetWare
          (Client)

Windows NT

Windows 2000

UNIX
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Setting Up the Printer on a Network

Windows 95/98/Me

For how to set up the printer as a network printer in a Windows 95/98/Me en-
vironment, see P.1 “Windows 95/98/Me Configuration”. There are two methods for
using the printer as a network printer.

Windows 2000

For how to set up the printer as a network printer in a Windows 2000 environ-
ment, see P.15 “Windows 2000 Configuration”. There are two methods for using
the printer as a network printer.

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

Windows 95/98/Me

TCP/IP

NetBEUI

IPP

Windows 95/98/Me

❖Printing Without Using a Print Server ❖Printing With a Windows 2000 or

   Windows NT Print Server

Windows 2000

TCP/IP

NetBEUI

IPP

Windows 2000

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

❖Printing Without Using a Print Server ❖Printing With a Windows 2000 or

   Windows NT Print Server
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Windows NT 4.0

For how to set up the printer as a network printer in a Windows NT 4.0 environ-
ment, see P.31 “Windows NT 4.0 Configuration”. There are two methods for using
the printer as a network printer.

Windows NT 4.0Windows NT 4.0

TCP/IP

NetBEUI

IPP

LPR

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

❖Printing Without Using a Print Server ❖Printing With a Windows 2000 or

   Windows NT Print Server
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NetWare

For how to set up the printer as a network printer in a NetWare environment,
see P.49 “NetWare Configuration”. The Network Interface Board allows you to
use the printer as either a print server or a remote printer.

For more information about setting up the clients, see the following pages.

• Windows 95/98/Me ⇒ P.68 “Windows 95/98/Me”

• Windows 2000 ⇒ P.69 “Windows 2000”

• Windows NT 4.0 ⇒ P.70 “Windows NT 4.0”

Configuring the printer as a print server

A dedicated NetWare print server is not required because the printer can be con-
figured as a print server.

The actual procedures for configuring the printer differ depending on the ver-
sion of NetWare.

• NetWare 3.x ⇒ P.55 “Setting Up as a Print Server”

• NetWare 4.x, 5 ⇒ P.61 “Setting Up as a Print Server”

NetWare
File Server

Print Server

Windows 95/98/Me Windows 2000 Windows NT 4.0
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Configuring the printer as a remote printer

If a dedicated NetWare print server is being used, the printer should be config-
ured as a remote printer.

The actual procedures for configuring the printer differ depending on the ver-
sion of NetWare.

• NetWare 3.x ⇒ P.57 “Setting Up as a Remote Printer”

• NetWare 4.x, 5 ⇒ P.65 “Setting Up as a Remote Printer”

Macintosh

For how to set up the printer as a network printer in a Macintosh environment,
see P.71 “Macintosh Configuration”.

NetWare
Print Server

NetWare
File Server

Remote Printer

Windows 95/98/Me Windows 2000 Windows NT 4.0

AppleTalk

Macintosh
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UNIX

For how to setup the printer as a network printer in a UNIX environment, see
UNIX Supplement provided as a PDF file on the CD-ROM labeled "Operating
Instructions".

TCP/IP

UNIX
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1. Windows 95/98/Me
Configuration

Configuring Windows 95/98/Me

Printing Without Using a Print Server

The following procedure describes how to configure Windows 95/98/Me to use
the printer on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows NT Server, Windows NT Workstation, or NetWare based print
server.

Printing with a Windows 2000 or Windows NT Print Server

See P.13 “Setting up a Client Computer” for how to configure Windows 95/98/Me
with a Windows 2000 or Windows NT print server.

Consult your network administrator about which of the three protocols are appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Decide on the protocol to use

         TCP/IP

4.  Install the software and set the printer driver port

"Using PortNavi" "Using Multidirect Print"

PortNavi

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI

   for Printing"

Multidirect Print

If using TCP/IP ... I f  using IPP or NetBEUI . . .

indicates topics explained in this document

IPP NetBEUI
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Configuring Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.

• Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)

• Assign an IP address and make other settings required for using the TCP/IP protocol.

Reference

For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

If DHCP is used to assign IP addresses, see P.97 “When Using DHCP”.

Note

❒ After setting the IP address, use the ping command to confirm that it has been
set correctly.

A Click [Start], point to [Programs], and then click [MS-DOS Prompt].

B Type the following. (Example IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message appears.
Request timed out.

Configuring a Windows 95/98/Me computer

Follow these steps to configure a Windows 95/98/Me computer to use the TCP/
IP protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “TCP/
IP” is listed in the [The following network components are installed:] box on the
[Configuration] tab.

Note

❒ If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab
and install it. For more information about installing the TCP/IP protocol,
see Windows 95/98/Me Help.

B Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Confirm with the network administrator that the settings are correct.
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Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.

• Confirm that the NetBEUI protocol is set to be active. (The factory default is
active.)

Reference

For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “Net-
BEUI” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

Note

❒ If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab
and install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

❒ If “NetBEUI ->Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.

B Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and click [Properties].

C Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
click [OK].

D Click [OK] to close the [Network] dialog box.

E When the message to restart appears, click [Yes].
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Using PortNavi

PortNavi is a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

❖❖❖❖ PortNavi features

• Send a print job directly to the network printers without using a print server.

• Notification when a printing error occurs.

• Print documents using other printers in the printer group when the speci-
fied printer is busy (Recovery Printing).

Important

❒ The following must be the same for the specified printer and the print-
ers selected for Recovery Printing.

• Printer models

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts)

• Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

Important

❒ The following must be the same for the specified printer and the print-
ers selected for Parallel Printing.

• Printer models

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts)

Limitation

❒ To use PortNavi you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

❒ For more information about installing PRINTER MANAGER FOR CLIENT,
see the “Setup Guide” that comes with the printer.

Note

❒ If you use the Multidirect Print port for printing, the port is switched auto-
matically to the PortNavi port.

❒ Be sure to close all applications before beginning the installation process. In-
stalling PortNavi may require the computer to be restarted.
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Installing PortNavi

Follow the procedure below to install PortNavi.

A Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the”Setup Guide”
that comes with the printer.

B Insert the CD-ROM into the CD-ROM drive.

Note

❒ If the installer starts automatically, you can use it to install PortNavi. Fol-
low the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
when the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After installation is complete, configure the printer port with PortNavi. ⇒ P.7
“Setting Up the Printer Driver”

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

A From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

B Click the [Details] tab and confirm that the PortNavi port is shown in the
[Print to the following port] box.

Remember the port name because this port should be deleted later.

C From the [Print to the following port] box, select [FILE].

D Click [Apply].

The port which is currently in use is changed.

E Click [Delete Port].

F Click the PortNavi port name as confirmed in step BBBB, then click [OK]. 

The port is deleted.

G Click [OK] to close the printer properties.

Uninstalling PortNavi

Preparation

Before uninstalling PortNavi, make sure that:

• The PortNavi settings dialog box is closed.

• No printer is using the PortNavi port as a printer port.

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B On the [Install/Uninstall] tab, click [PortNavi], and click [Add/Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of PortNavi.

D After a confirmation message, click [Yes].

E Confirm the [Remove Shared Files?] dialog box.

F When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

Preparation

The target printer must be turned on before starting the installation process.

A Install the printer driver of the printer you want to use.

B From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

C Click the [Details] tab and click [Add Port].

D Click [Other], click [PortNavi] from the list and then click [OK].

The [Select Printer] dialog box appears .

The displayed items are as follows:

Model Name: The model name of the printer. 

Name: The name of the Network Interface Board.

Comment: Additional information about the Network Interface Board.

Address: The IP address of the printer.

E Click the model name of the printer, and then click [OK].

Note

❒ If you want to select any printer which is not shown here, click [IP Address]
and input the IP address of the printer.

F Confirm that the PortNavi port name is shown in the [Print to the following
port] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".

The configuration is now complete. 

When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure for
Notice, Parallel Printing and Recovery Printing.

Reference

For more information about these settings, see PortNavi Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Details] tab and click [Port Settings]. 

The PortNavi settings dialog box appears.
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Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the “Setup
Guide” that comes with the printer.

Preparation

Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted.

A Close all the applications that are currently running.

B Insert the CD-ROM into the CD-ROM drive.

Note

❒ If the installer starts automatically, you can use it to install Multidirect
Print. Follow the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\MDP\DISK1\SETUP.EXE” (do not
include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\MDP\DISK1\SETUP.EXE” when
the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you use, and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After installation is complete, configure the printer port with Multidirect
Print. ⇒ P.10 “Setting Up the Printer Driver”

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].
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Uninstalling Multidirect Print

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B On the [Install/Uninstall] tab, click [Multidirect Print], and click [Add/Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of Multidirect Print.

D When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected. 

Preparation

The target printer must be turned on before starting the installation process.

A Install the printer drivers.

If the printer drivers have already been installed, you can proceed to the next
step.

Reference

For more information about installing the printer drivers, see the "Setup
Guide" that comes with the printer.

Note

❒ Any port can be selected during the installation, however, LPT1 is recom-
mended.

B From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

C Click the [Details] tab, and then click [Add Port].

D In the [Add Port] box, click [Other], click [Multidirect Print], and then click [OK].

The [Select Printer] dialog box appears, and the printers which can be printed
to by TCP/IP are displayed.

Limitation

❒ If PRINTER MANAGER FOR CLIENT is not installed on the computer,
printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the "Setup Guide" that
comes with the printer.
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E Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For exam-
ple, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be used. Sim-
ilarly, when “192.168.0.20” is already used, “192.168.0.2” cannot be used. 

NetBEUI

A Click [NetBEUI].

A list of printers that can be printed to by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
configuration page. For more information about the printing of config-
uration page, see the "Printer Reference" that comes with the printer.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.

B In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-
dress of the printer.

(Example IP address is 192.168.15.16)

http://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address typed in [Printer URL] will be set as the IPP port name.

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note

❒ For more information about these settings, see Multidirect Print Help.
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F Click [OK].

G Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and click [OK].

This completes the settings.

To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow these steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

Note

❒ There are no settings for the NetBEUI protocol.

A From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Details] tab, and then click [Port Settings].

The [Port Settings] dialog box appears.

• For the TCP/IP protocol, you can configure Timeout Settings.

• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

Note

❒ For more information about these settings, see Multidirect Print Help.
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Setting up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.

To print from Windows 95/98/Me, you must install the printer driver and
change the printer port to the print server.

Note

❒ This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

A Install the printer driver as a local printer.

Reference

For more information about installing the printer driver, see the "Setup
Guide" that comes with the printer.

Note

❒ Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

C Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

D Click the [Details] tab, and click [Add Port].

E Click [Network], and click [Browse].

Windows 2000 or 
Windows NT Print Server

Windows 95/98/Me
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F On the network tree, double-click the name of the computer used as the
print server.

The printers attached to the network are displayed.

G Click the name of the printer you want to use, and click [OK].

H Click [OK].

I Confirm that the port name is displayed in the [Print to the following port] box,
and click [OK].
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2. Windows 2000
Configuration

Configuring Windows 2000

Printing Without Using a Print Server

The following procedure describes how to configure Windows 2000 to use the
printer on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

Consult your network administrator about which of the three protocols are appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Decide on the protocol to use

         TCP/IP

4.  Install the software and set the printer driver port

"Using PortNavi" "Using Multidirect Print"

PortNavi

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI

   for Printing"

Multidirect Print

If using TCP/IP ... I f  using IPP or NetBEUI . . .

indicates topics explained in this document

IPP NetBEUI
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Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

Printing with a LPR Port

See P.28 “Configuring LPR Port Printing” for how to configure a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See P.29 “Setting up a Client Computer” for how to configure Windows 2000 with
a Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.

• Confirm that the TCP/IP protocol is set to be active. (The factory default is ac-
tive.)

• Assign an IP address and make other settings required for using the TCP/IP
protocol.

Reference

For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

If DHCP is used to assign IP addresses, see P.97 “When Using DHCP”.

Note

❒ After setting the IP address, use the ping command to confirm that it has been
set correctly.

A Click [Start], point to [Programs], point to [Accessories] and then click [Com-
mand Prompt].

B Type the following. (Example IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message appears.
Request timed out.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP
protocol.

A Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

B Click [Local Area Connection]. On the [File] menu, click [Properties].
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C Confirm that “Internet Protocol (TCP/TP)” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

Note

❒ If the check box of TCP/IP protocol is not selected, select the box.

❒ If the TCP/IP protocol is not installed, click [Install] on the [General] tab and
install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

D Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Confirm with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.

• Confirm that the NetBEUI protocol is set to be active. (The factory default is
active.)

Reference

For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

A Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

B Click [Local Area Connection]. On the [File] menu, click [Properties].

C Confirm that “NetBEUI Protocol” is selected in the [Components checked are
used by this connection:] box on the [General] tab.

Note

❒ If the check box of the NetBEUI protocol is not selected, select the box.

❒ If the NetBEUI protocol is not installed, click [Install] on the [General] tab
and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.
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Using PortNavi

PortNavi is a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

❖❖❖❖ PortNavi features

• Send a print job directly to the network printers without using a print server.

• Notification when a printing error occurs.

• Print documents using other printers in the printer group when the speci-
fied printer is busy (Recovery Printing).

Important

❒ The following must be the same for the specified printer and the print-
ers selected for Recovery Printing.

• Printer models

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts)

• Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

Important

❒ The following must be the same for the specified printer and the print-
ers selected for Parallel Printing.

• Printer models

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts)

Limitation

❒ To use PortNavi you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

❒ For more information about installing PRINTER MANAGER FOR CLIENT,
see the “Setup Guide” that comes with the printer.

Note

❒ If you use the Multidirect Print port for printing, the port is switched auto-
matically to the PortNavi port.

❒ Be sure to close all applications before beginning the installation process. In-
stalling PortNavi may require the computer to be restarted.
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Installing PortNavi

Follow the procedure below to install PortNavi.

A Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the”Setup Guide”
that comes with the printer.

B Insert the CD-ROM into the CD-ROM drive.

Note

❒ If the installer starts automatically, you can use it to install PortNavi. Fol-
low the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D Click [Add New Programs], and then click [CD or Floppy].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Open] box, followed by
“:\NETWORK\PORTNAVI\DISK1\SETUP.EXE” (do not include the
quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
when the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you use, and then
click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After installation is complete, configure the printer port with PortNavi. ⇒
P.22 “Setting Up the Printer Driver”

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

A From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

B Click the [Ports] tab and confirm that the PortNavi port is shown in the [Print
to the following port(s)] box.

Remember the port name because this port should be deleted later.

C Click the [FILE] check box in the [Port] column.

D Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

E Open the Printer Properties of the same printer.

F Click to select the [Ports] tab.

G At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the PortNavi port name as confirmed in step BBBB. 

H Click [Delete Port].

I When the confirmation message appears, click [Yes].

The port is deleted.

J Click [Close] to close the Printer Properties.

Uninstalling PortNavi

Preparation

Before uninstalling PortNavi, make sure that:

• The port settings dialog box is closed.

• No printer is using the PortNavi port as a printer port.

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B Click the [Change or Remove Programs] tab, click [PortNavi], and click [Change/
Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of PortNavi.
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D After a confirmation message appears, click [Yes].

E Confirm the [Remove Shared File?] dialog box.

F When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

Preparation

The target printer must be turned on before starting the installation process.

A Install the printer driver of the printer you want to use.

B From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

C Click the [Ports] tab and click [Add Port].

D Click [PortNavi] in the [Available port types:] box, and then click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed. 

The displayed items are as follows: 

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.

Address: The IP address of the printer.

E Click the model name of the printer, and then click [OK].

Note

❒ If you want to select any printer which is not shown here, click [IP Address]
and input the IP address of the printer.

F Confirm that the PortNavi port name is shown in the [Print to the following
port(s)] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".

The configuration is now complete. 

When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure No-
tice, Parallel Printing and Recovery Printing.

Reference

For more information about these settings, see PortNavi Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Ports] tab and click [Configure Port]. 

The PortNavi settings dialog box appears.
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Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the “Setup
Guide” that comes with the printer.

Preparation

Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted. 

A Close all the applications that are currently running.

B Insert the CD-ROM into the CD-ROM drive.

Note

❒ If the installer starts automatically, you can use it to install Multidirect
Print. Follow the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D Click [Add New Programs], and then click [CD or Floppy].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Open] box, followed by
“:\NETWORK\MDP\DISK1\SETUP.EXE” (do not include the quotation
marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\MDP\DISK1\SETUP.EXE” when
the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you use, and then
click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After installation is complete, configure the printer port with Multidirect Print. ⇒
P.25 “Setting Up the Printer Driver”

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].
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Uninstalling Multidirect Print

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B Click [Change or Remove Programs], click [Multidirect Print], and click [Change/
Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of Multidirect Print.

D When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected. 

Preparation

The target printer must be turned on before starting the installation process.

A Install the printer drivers.

If the printer drivers have already been installed, you can proceed to the next
step.

Reference

For more information about installing the printer drivers, see the "Setup
Guide" that comes with the printer.

Note

❒ Any port can be selected during the installation, however, LPT1 is recom-
mended.

B From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Ports] tab, and click [Add Port].

D In the [Available Printer Ports] box, click [Multidirect Print] , and then click [New
Port].

The [Add Port] dialog box appears, and the printers which can be printed to by
TCP/IP are displayed.

Limitation

❒ If PRINTER MANAGER FOR CLIENT is not installed on the computer,
printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the "Setup Guide" that
comes with the printer.
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E Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI].

A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
configuration page. For information about the printing of configuration
page, see the "Setup Guide" that comes with the printer.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.

B In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-
dress of the printer.

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

(Example IP address is 192.168.15.16)

http://192.168.15.16/printer

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note

❒ For more information about these setting, see Multidirect Print Help.

F Click [OK].
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G Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and click [Close].

This completes the settings.

To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow the steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

Note

❒ There are no settings for the NetBEUI protocol.

A From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Ports] tab, and then click [Configure Port].

The [Port Settings] dialog box appears

• For TCP/IP protocol, you can configure Timeout Settings.

• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

Note

❒ For more information about these settings, see Multidirect Print Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

Note

❒ The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocol, see P.17 “Configuring TCP/IP and
IPP for Printing”.

A Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C In the [Available port types:] box, click “LPR Port”, and then click [New Port].

Note

❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled.

D Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd:] box.

E Type “lp” into the [Name of printer or print queue on that server box:], and click
[OK].

F Click [Close].

G Confirm that the port name is displayed in the [Print to the following port(s)]
box and the check mark is inside the check box, and then click [OK].
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Setting up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.

To print from Windows 2000, you must install the printer driver and change the
printer port to the print server.

Note

❒ This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

C Click [Next >].

D Click [Network printer], and click [Next >].

E In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.

Windows 2000

Windows 2000 or 
Windows NT Print Server
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F Click the printer you want to use, and click [Next >].

Note

❒ If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

❒ There is a Windows 2000 printer driver on the CD-ROM that comes with
the printer.

G Select whether to use this printer as the default printer, and click [Next >].

H After installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.
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3. Windows NT 4.0
Configuration

Configuring Windows NT 4.0

Printing Without Using a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
printer on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

Consult your network administrator about which of the three protocols are appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Decide on the protocol to use

         TCP/IP

4.  Install the software and set the printer driver port

"Using PortNavi" "Using Multidirect Print"

PortNavi

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI

   for Printing"

Multidirect Print

If using TCP/IP ... I f  using IPP or NetBEUI . . .

indicates topics explained in this document

IPP NetBEUI
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Printing with a LPR Port

See P.45 “Configuring LPR Port Printing” for how to configure a LPR port in Win-
dows NT 4.0.

Printing with a Windows 2000 or Windows NT Print Server

See P.46 “Setting up a Client Computer” for how to configure Windows NT 4.0
with a Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.

• Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)

• Assign an IP address and make other settings required for using the TCP/IP
protocol.

Reference

For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

If DHCP is used to assign IP addresses, see P.97 “When Using DHCP”.

Note

❒ After setting the IP address, use the ping command to confirm that it has been
set correctly.

A Click [Start], point to [Programs], and then click [Command Prompt].

B Type the following. (Example IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message appears.
Request timed out.

Configuring a Windows NT computer

Follow these steps to configure a Windows NT computer to use the TCP/IP protocol.

A Open [Control Panel] and double-click the [Network] icon. Confirm that “TCP/
IP Protocol” is listed in the [Network protocols] box on the [Protocols] tab.

Note

❒ If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab and
install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.

B Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Confirm with the network administrator that the settings are correct.
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C Click the [Services] tab, and confirm that “Microsoft TCP/IP Printing” is in-
stalled.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services ]
tab, and install it. For more information about installing and configuring net-
work services, see Windows NT Help.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.

• Confirm that the NetBEUI protocol is set to be active. (The factory default is
active.)

Reference

For more information about how to make the above settings, see the "Setup
Guide" that comes with the printer.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and change the
LAN adapter number (Lana Number).

A Open [Control Panel] and double-click the [Network] icon. Confirm that “Net-
BEUI Protocol” is listed in the [Network Protocols] box on the [Protocols] tab.

Note

❒ If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab,
and install it. For more information about installing the NetBEUI protocol,
see Windows NT Help.

B Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Network Services] box , and click [Properties].

C Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and click [Edit].

D Type “0” as the Lana Number.

Note

❒ If the other protocol's Lana Number is configured with “0”, you must
change the Lana Number a number other than “0”.

E Click [OK].
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F Click [Close], and close the [Network] dialog box.

G After confirming the message to restart, click [Yes].

Note

❒ After you change the Lana Number, you must restart the computer.
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Using PortNavi

PortNavi is a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

❖❖❖❖ PortNavi features

• Send a print job directly to the network printers without using a print server.

• Notification when a printing error occurs.

• Print documents using other printers in the printer group when the speci-
fied printer is busy (Recovery Printing).

Important

❒ The following must be the same for the specified printer and the print-
ers selected for Recovery Printing.

• Printer models

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts)

• Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

Important

❒ The following must be the same for the specified printer and the print-
ers selected for Parallel Printing.

• Printer models

• Installed options (e.g. Paper Tray)

• Size and orientation of paper in each paper tray

• Total memory

• Installed fonts (including the downloaded fonts)

Limitation

❒ To use PortNavi you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

❒ For more information about installing PRINTER MANAGER FOR CLIENT,
see the “Setup Guide” that comes with the printer.

❒ On a computer that is used as a print server, do not use the features such as
Parallel Printing, Recovery Printing and Notify. For more information about
turning off these features, see PortNavi Help.
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Note

❒ If you use the Multidirect Print port for printing, the port is switched auto-
matically to the PortNavi port.

❒ Be sure to close all applications before beginning the installation process. In-
stalling PortNavi may require the computer to be restarted.

Installing PortNavi

Follow the procedure below to install PortNavi.

A Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the”Setup Guide”
that comes with the printer.

B Insert the CD-ROM into the CD-ROM drive.

Note

❒ If the installer starts automatically, you can use it to install PortNavi. Fol-
low the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PORTNAVI\DISK1\SETUP.EXE”
when the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After installation is complete, configure the printer port with PortNavi. ⇒
P.39 “Setting Up the Printer Driver”

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

A From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

B Click the [Details] tab and confirm that the PortNavi port is shown in the
[Print to the following port] box.

Remember the port name because this port should be deleted later.

C From the [Print to the following port] box, select [FILE].

D Click [Apply].

The port which is currently in use is changed.

E Click [Delete Port].

F Click the PortNavi port name as confirmed in step BBBB, then click [OK]. 

The port is deleted.

G Click [OK] to close the printer properties.

Uninstalling PortNavi

Preparation

Before uninstalling PortNavi, make sure that:

• The port settings dialog box is closed.

• No printer is using the PortNavi port as a printer port.

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B On the [Install/Uninstall] tab, click [PortNavi], and click [Add/Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of PortNavi.

D After a confirmation message appears, click [Yes].

E Confirm the [Remove Shared File?] dialog box.

F When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

Preparation

The target printer must be turned on before starting the installation process.

A Install the printer driver of the printer you want to use.

B From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

C Click the [Details] tab and click [Add Port].

D Click [Other], click [PortNavi] from the list and then click [OK].

The [Select Printer] dialog box appears .

The displayed items are as follows:

Model Name: The model name of the printer. 

Name: The name of the Network Interface Board.

Comment: Additional information about the Network Interface Board.

Address: The IP address of the printer.

E Click the model name of the printer, and then click [OK].

Note

❒ If you want to select any printer which is not shown here, click [IP Address]
and input the IP address of the printer.

F Confirm that the PortNavi port name is shown in the [Print to the following
port] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".

The configuration is now complete. 

When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure No-
tice, Parallel Printing and Recovery Printing.

Reference

For more information about these settings, see PortNavi Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Details] tab and click [Port Settings]. 

The PortNavi settings dialog box appears.



Using Multidirect Print

41

3

Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the “Setup
Guide” that comes with the printer.

Preparation

Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted.

A Close all the applications that are currently running.

B Insert the CD-ROM into the CD-ROM drive.

Note

❒ If the installer starts automatically, you can use it to install Multidirect
Print. Follow the instructions on the screen.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].

E Click [Next >].

F Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “:\NETWORK\MDP\DISK1\SETUP.EXE” (do not
include the quotation marks), and then click [Finish].

Note

❒ An example would be “D:\NETWORK\MDP\DISK1\SETUP.EXE” when
the drive letter is “D”.

G From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

Follow the instructions on the screen.

After installation is complete, configure the printer port with Multidirect Print. ⇒
P.42 “Setting Up the Printer Driver”

Note

❒ If the dialog box asking if you want to restart the computer appears, select
[Yes, I want to restart my computer now.].
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Uninstalling Multidirect Print

A Open [Control Panel], and double-click the [Add/Remove Programs] icon.

B On the [Install/Uninstall] tab, click [Multidirect Print], and click [Add/Remove].

C After a confirmation message appears, click [Yes].

UninstallShield removes all of the components of Multidirect Print.

D When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected. 

Preparation

The target printer must be turned on before starting the installation process.

A Install the printer drivers.

If the printer drivers have already been installed, you can proceed to the next
step.

Reference

For more information about installing the printer drivers, see the "Setup
Guide" that comes with the printer.

Note

❒ Any port can be selected during the installation, however, LPT1 is recom-
mended.

B From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Ports] tab, and click [Add Port].

D In the [Available Printer Ports] box, click [Multidirect Print] , and then click [New
Port].

The [Select Printer] dialog box appears, and the printers which can be printed
to by TCP/IP are displayed.

Limitation

❒ If PRINTER MANAGER FOR CLIENT is not installed on the computer,
printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the "Setup Guide" that
comes with the printer.
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E Select the printer.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

A Click [NetBEUI].

A list of printers that can be printed by the NetBEUI protocol appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
configuration page. For information about the printing of configuration
page, see the "Setup Guide" that comes with the printer.

❒ You cannot print to printers beyond routers.

IPP

A Click [IPP].

The IPP setting dialog box appears.

B In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-
dress of the printer.

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

(Example IP address is 192.168.15.16)

http://192.168.15.16/printer

D If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note

❒ For more information about these setting, see Multidirect Print Help.

F Click [OK].
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G Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and click [OK].

This completes the settings.

To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow the steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

Note

❒ There are no settings for the NetBEUI protocol.

A From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Ports] tab, and then click [Port Configuration].

The [Port Settings] dialog box appears

• For TCP/IP protocol, you can configure Timeout Settings.

• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

Note

❒ For more information about these settings, see Multidirect Print Help.



Configuring LPR Port Printing

45

3

Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

Note

❒ The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

❒ The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocol, see P.33 “Configuring TCP/IP and
IPP for Printing”.

A Click [Start], point to [Settings], and then click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

C Click the [Ports] tab, and then click [Add Port].

D In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

Note

❒ If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been
installed.

E Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd] box.

F Type “lp” into the [Name of printer or print queue on that server] box, and click
[OK].

G Click [Close].

H Confirm that the port name is displayed in the [Print to the following port(s)]
box and the check mark is inside the check box, and then click [OK].
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Setting up a Client Computer

This section describes the procedures for setting up a client in a network that uses
Windows 2000, Windows NT Server or Windows NT Workstation as a print server.

To print from Windows NT 4.0, you must install the printer driver and change
the printer port to the print server.

Note

❒ This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.

A Click [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

C Click [Network printer server], and click [Next >].

D In the [Shared Printers] box, double-click the name of the computer used as a
print server.

The printers attached to the network are displayed.

E Click the printer you want to use, and click [OK].

Note

❒ If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

❒ There is a Windows NT printer driver on the CD-ROM that comes with the
printer.

Windows NT 4.0

Windows 2000 or 
Windows NT Print Server
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F Select whether to use this printer as the default printer, and click [Next >].

G After installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.
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4. NetWare Configuration

This chapter describes how to configure the printer to use as a print server or a
remote printer in a NetWare environment.

Note

❒ NetWare must be set to active using the operation panel of the printer. For
more information about how to set it, see the "Setup Guide" that comes with
the printer.

Installing the NIB Setup Tool

A utility called the NIB Setup Tool is provided to configure the printer to work
in a network environment. This section describes how to install PRINTER MAN-
AGER FOR ADMINISTRATOR, and how to run the NIB Setup Tool.

Limitation

❒ The NIB Setup Tool is supported to work with the following operating sys-
tems.

• Microsoft Windows 95/98/Me

• Microsoft Windows 2000

• Microsoft Windows NT 4.0

Installing PRINTER MANAGER FOR ADMINISTRATOR

Follow these steps to install PRINTER MANAGER FOR ADMINISTRATOR.

Preparation

You should install PRINTER MANAGER FOR ADMINISTRATOR on the
computer. If you install PRINTER MANAGER FOR ADMINISTRATOR from
a file server or run it via the network, PRINTER MANAGER FOR ADMINIS-
TRATOR might not work correctly.

Be sure to close all applications before starting the installation procedure.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the installer starts automatically, follow the instructions on the screen.

If not, go to step C.

C Open [Control Panel], and double-click the [Add/Remove Programs] icon.

D On the [Install/Uninstall] tab, click [Install].
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E Click [Next >].

F In the [command line for installation program] box, type the name of the CD-ROM
drive followed by “:\NETWORK\PRINTMAN\ADMIN\DISK1\SETUP.EXE”
(do not include the quotation marks) and then click [Finish].

Note

❒ An example would be “D:\NETWORK\PRINTMAN\ADMIN\DISK1\SETUP.EXE”
when the CD-ROM drive name is “D”.

G From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

H After the [Welcome] dialog box appears, click [Next >].

I The [Software License Agreement] dialog box appears. 

After reading through all of the contents by clicking [PageDown], click [Yes] to
agree with the License Agreement.

J Select a folder to install PRINTER MANAGER FOR ADMINISTRATOR
in, and then click [Next >].

If you want to change the displayed folder, click [Browse] to select another
one.

The installation program starts.

When a confirmation dialog box appears, the installation program is com-
plete.

Running the NIB Setup Tool

A Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [PRINT-
ER MANAGER FOR ADMINISTRATOR] program folder.
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Quick Setup Using the NIB Setup Tool 
Wizard

Using the NIB Setup Tool, you can easily set up a NetWare printing environment. 

Reference

For more information about installing the NIB Setup Tool, see P.49 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure the Network Interface Board for the first time, use the Wiz-
ard method.

If you want to use the Property Sheet method, see P.54 “NetWare 3.x - Advanced
Settings” or P.60 “NetWare 4.x, 5 - Advanced Settings”.

Note

❒ This section assumes that NetWare is functional and that the necessary envi-
ronment for NetWare Print Services is available.

❒ If you configure the Network Interface Board in a NetWare environment us-
ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.

• Windows 95/98/Me in NDS mode configuration

• Windows NT 4.0 in NDS mode configuration

• Windows NT 4.0 in Bindery mode configuration

• Windows 2000 in NDS mode configuration

• Windows 2000 in Bindery mode configuration

A Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.50 “Running the NIB Setup Tool”

C Click [Wizard] and click [OK].

The [Network board list] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click to select the IPX address of the Network Interface Board you are con-
figuring, and click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
print a network configuration page to confirm the MAC address (Network
address).
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F Confirm that the MAC address and IPX address are correct, and click [Finish].

G Type the print server name into the [Device Name] box, and click [Next >].

The default setting is “RDP_” followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

H In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

I Click [Next >].

A dialog box for configuring the NetWare environment appears.

J Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

K If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

L If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among those
listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

M Click [Next >].

N Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1”
and that for Print Queue Name is “Print Server Name” followed by “_Q”
(quotation marks are not included). You can change them if necessary.

O If you have selected NDS mode, type the volume of the print queue into the
[Queue Volume] box. 

Clicking [Browse], you can select one of those shown in the [Browse] dialog box.
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P Click [Next >].

A dialog box to confirm the printing environment appears.

Q After confirming the environment, click [Next >].

If you want to change the settings, click [< Back] and make the settings again.

Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

R After a confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the printer differ depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 3.x environment.

Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. ⇒ P.51 “Quick Setup Using the NIB Setup Tool Wizard”

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Install the NIB Setup Tool

Print Server Remote Printer

Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Turn the power
off and on

Start the print server
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Setting Up as a Print Server

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see a network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.

I Click the [NetWare] tab, and make the following settings.

A Select [Bindery].

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

C Click [OK] to close the property sheet.

D After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K Type “PCONSOLE” from the command prompt.

F:> PCONSOLE
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L Create a print queue as follows.

Note

❒ If you use a currently defined print queue, go to step M.

A From the [Available Options] menu, select [Print Queue Information] and press
the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key and type a print queue name.

C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

M Create a printer as follows.

A From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key and type a print
server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important

❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].

D From the [Print Server Configuration] menu, select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

F If you want to change the name of the printer, type a new name.

A name "Printer x" is assigned to the printer. “x” stands for the number of
the selected printer.

G As Type, select [Remote Other/Unkown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to the [Print Server Configuration] menu.

N Assign print queues to the created printer as follows.

A From the [Print Server Configuration] menu, select [Queues Serviced By Printer].

B Select the printer created in step MMMM.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note

❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, confirm that the queues are as-
signed.

O Press the {{{{ESC}}}} key until “Exit?” appears, and select [Yes] to exit PCONSOLE.
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P Turn the printer power off and on.

Note

❒ To confirm that the printer is configured correctly, type as follows from the
command prompt.

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
an attached user.

Setting Up as a Remote Printer

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see a network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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I Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name] box, type the name of the print server.

B In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

C In the [Print Server Operation Mode] group, click [As Remote Printer].

D In the [Remote Printer No.] box, type the printer number.

Important

❒ Use the same printer number as that to be created in the printer server.

E Click [OK] to close the property sheet.

F After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K Type “PCONSOLE” from the command prompt.

F:> PCONSOLE

L Create a print queue as follows.

Note

❒ If you use a currently defined print queue, go to step L.

A From the [Available Options] menu, select [Print Queue Information] and press
the {{{{ENTER}}}} key.

B Press the {{{{INSERT}}}} key and type a print queue name.

C Press the {{{{ESC}}}} key to return to the [Available Options] menu.

M Create a printer as follows.

A From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

B To create a new print server, press the {{{{INSERT}}}} key and type a print
server name.

If you use an currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important

❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

C From the [Print Server Information] menu, select [Print Server Configuration].

D From the [Print Server Configuration] menu, select [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

Important

❒ Use the same number as that specified as Remote Printer No. using the
NIB Setup Tool. (Step I-D).
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F If you change the name of the printer, type a new name.

A name "Printer x" is assigned to the printer. x stands for the number of the
selected printer.

G As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

H Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to [Print Server Configuration Menu].

N Assign print queues to the created printer as follows.

A From [Print Server Configuration Menu], select [Queues Serviced By Printer].

B Select the printer created in step LLLL.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note

❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, confirm that the queues are as-
signed.

O Press the {{{{ESC}}}} key until “Exit?” appears, and select [Yes] to exit PCONSOLE.

P Start the print server by typing the following from the console of the Net-
Ware Server.

 If it is running, restart it after exiting it.

❖❖❖❖ To exit

CAREE: unload pserver

❖❖❖❖ To start

CAREE: load pserver print_server_name

Note

❒ If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5 - Advanced Settings

The actual procedures for configuring the printer differ depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5 environment.

❖❖❖❖ To use NetWare 5

• You cannot use the NDPS (Novell Distributed Print Services) mode.

• If you use Pure IP, configure the printer to use the TCP/IP protocol. For
more information about how to make the settings, see the “Setup Guide”
that comes with the printer.

Preparation

The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. ⇒ P.51 “Quick Setup Using the NIB Setup Tool Wizard”

Note

❒ This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

❒ You should install the client software released from Novell on the Windows
before running the NIB Setup Tool for configuring in NDS mode or using
Windows NT 4.0.

Install the NIB Setup Tool

Print Server Remote Printer

Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Turn the power
off and on

Start the print server
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Setting Up as a Print Server

Important

❒ You can set up the print server using the NDS or Bindery mode in NetWare
4.x, 5. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. ⇒ P.51 “Quick Setup Using the NIB
Setup Tool Wizard”.

Note

❒ If you use Pure IP in NetWare 5, follow the procedure on P.63 “Using Pure IP
in the NetWare 5 environment”.

A Log on to the file server as an Admin or an Admin equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see a network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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I Click the [NetWare] tab, and make the following settings.

A Select [NDS].

B Type into the [Tree:] box the name of the NDS tree in which the print
server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

C Click [OK] to close the property sheet.

D After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K From Windows, run NWAdmin.

Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

L Create a print queue as follows.

A Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and click [OK].

C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue Volume] box, click the [Browse] button.

E In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

F After confirming the settings, click [Create].

M Create a printer as follows.

A Select the container object the printer is located in, and click [Create] on
the [Object] menu.

B In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5, click “Printer (Non NDPS)”.

C In the [Printer name] box, type the name of the printer.

D Click [Define additional properties] to check a box, and click [Create].



NetWare 4.x, 5 - Advanced Settings

63

4

N Assign print queues to the created printer as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step LLLL, and click
[OK].

C Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication]. 

D Click [Manual load] in the [Communication type] group, and click [OK].

E After confirming the settings, click [OK].

O Create a print server as follows.

A Select the context specified using the NIB Setup Tool (step IIII-AAAA), and on
the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5, click “Print Server (Non NDPS)”.

C In the [Print Server name] box, type the name of the print server.

Important

❒ Use the same name as that specified using the NIB Setup Tool. (Step H)

D Click [Define additional properties] to check a box, and click [Create].

P Assign the printer to the created print server as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the printer created in step MMMM, and click
[OK].

C After confirming the settings, click [OK].

Q Turn the printer power off and on.

Note

❒ If the printer works as configured, the name of the print server appears as
an attached user.

Using Pure IP in the NetWare 5 environment

A Log on to the file server as an Admin or an Admin equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Network board list] dialog box appears.
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D Click [TCP/IP protocol].

E Click the IP address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring,
see a network configuration page to confirm the MAC address (Network
Address).

F Confirm that the MAC address and IP address are correct, and click [Finish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device
Name:] box.

I Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name:] box, type the name of the print server.

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

C In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

D In the [Print Server Operation Mode] group, click [As Print Server].

E Click [OK] to close the property sheet.

F After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

After this step, go to step K on P.61 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

A Log on to the file server as an Admin or an Admin equivalent.

B Run the NIB Setup Tool.

Reference

⇒ P.50 “Running the NIB Setup Tool”

C Click [Property Sheet] and click [OK].

The [Browse] dialog box of the Network Interface Board appears.

D Click [IPX protocol].

E Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note

❒ If you do not know which Network Interface Board you are configuring, see a
network configuration page to confirm the MAC address (Network Address).

F Confirm that the MAC address and IPX address are correct, and click [Finish].

The [NIB Setup Tool] window appears.

G Click [Configure].

The property sheet appears.

H Click the [General] tab, and type the name of the print server into the [Device Name] box.

I Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name] box, type the name of the print server.

B In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

C In the [NDS Context] box, type the context in which the print server is to be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.

As an context, object names are typed from a lower level object and divid-
ed by a period. For example, if you want to create a print server into NET
under DS, type “NET.DS”.
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D In the [Print Server Operation Mode] group, click [As Remote Printer].

E In the [Remote Printer No.] box, type the number of the printer.

Important

❒ Use the same number as that of the printer to be created in the print
server.

F Click [OK] to close the property sheet.

G After a confirmation dialog box appears, click [OK].

J On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

K From Windows, run NW Admin.

Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

L Create a print queue as follows.

A Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

B In the [Class of new object] box, click “Print Queue”, and click [OK].

C In the [Print Queue name] box, type the name of the print queue.

D In the [Print Queue Volume] box, click [Browse] button.

E In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

F After confirming the settings, click [Create].

M Create a printer as follows.

A Select the container object the printer is located in, and click [Create] in
the [Object] menu.

B In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5, click “Printer (Non NDPS)”.

C In the [Printer name] box, type the name of the printer.

D Click [Define additional properties] to check a box, and click [Create].

N Assign print queues to the created printer as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step LLLL, and click
[OK].

C Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication]. 

D Click [Manual load] in the [Communication type] group, and click [OK].

E After confirming the settings, click [OK].
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O Create a print server as follows.

A Select the context specified using the NIB Setup Tool (Step IIII-AAAA), and on
the [Object] menu, click [Create].

B In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5, click “Print Sever (Non NDPS)”.

C In the [Print Server name] box, type the name of the print server.

Important

❒ Use the same name as that specified using the NIB Setup Tool. (Step H).

D Click [Define additional properties] to check a box, and click [Create].

P Assign the printer to the created print server as follows.

A Click [Assignments], and click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in the step MMMM, and
click [OK].

C In the [Printers] group, click the printer assigned in step BBBB , and click
[Printer Number].

D Type the printer number and click [OK].

Important

❒ Use the same number as that specified as Remote Printer No. using the
NIB Setup Tool. (Step I-E).

E After confirming the settings, click [OK].

Q Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name



NetWare Configuration

68

4

Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Note

❒ This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client. 

Preparation

Log on to the NetWare file server before starting the following procedure.

A Install the printer driver you want to use as “Local printer”.

Reference

For more information about installing the printer driver, see the "Setup
Guide" that comes with the printer.

Note

❒ Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

C In the [Printers] window, click the icon of the printer you want to use. 

D On the [File] menu, click [Properties].

E Click the [Details] tab, and click [Add Port].

F Click [Network] and click [Browse].

G On the network tree, double-click the name of the file server.

The queues are displayed.

H Click the queue you want to print, and click [OK].

I Click [OK].

In the [Print to the following port] box, a network path to the printer appears.

J Click [OK] to close the Printer Properties, and again, open it.
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K Click the [Printer Settings] tab.

L Click to clear the [Form feed] and [Enable banner] check boxes.

Note

❒ You should not check these boxes because they should be specified using
the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.

A Click the [PostScript] tab. 

B Click [Advanced].

C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

M Click [OK] to close the Printer Properties.

Windows 2000

Follow the procedure to set up a Windows 2000 client.

Preparation

Log on to the NetWare file server before starting the following procedure.

A Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The printers dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM into the CD-ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the "Setup Guide" that comes with the printer.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.
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Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

Preparation

Log on to the NetWare file server before starting the following procedure.

A Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM into the CD-ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the "Setup Guide" that comes with the printer.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.
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Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may differ depending on the
version of the Mac OS. The following procedure describes how to configure Mac
OS 8. If you are not using Mac OS 8, see the manual that comes with your version
of the Mac OS for more information.

Limitation

❒ To print from a Macintosh, use PostScript 3.

Changing to EtherTalk

Follow the procedure to configure a Macintosh computer to use EtherTalk.

Reference

For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

A Open [Control Panel], and double-click the [AppleTalk] icon.

B From the [Connect via:] pop-up menu, select “Ethernet”.

C If you change zones, select a name from the [Current zone:] pop-up menu.

D Close the [AppleTalk] control panels.

E Restart the Macintosh.

Change to EtherTalk

Basic Procedure

Configure the printer

Change the printer name

Change the zone
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Configuring the Printer

Use the operation panel to activate the EtherTalk protocol. (The factory default
is active.)

Reference

For more information about configuration, see the "Setup Guide" that comes
with the printer.

Changing the Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printer1” and “printer2”. 

To change the printer name in the Macintosh EtherTalk environment, use Print-
er Utility for Mac included on the CD-ROM labeled "Drivers and Utilities".

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
Printer Utility for Mac included on the CD-ROM labeled "Drivers and Utilities".

Reference

For more information about using Printer Utilities for Mac, see PostScript 3
Operating Instructions Supplement provided as a PDF file on the CD-ROM
labeled "Operating Instructions".



73

6. Appendix

Configuring the Network Interface Board 
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
a printer to function as a network printer. You can use a Web Browser to view
the printer status and configure the Network Interface Board.

❖❖❖❖ Configuring the printer
This requires the TCP/IP protocol to be installed. After the printer has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

Reference

For more information about configuring the printer to use the TCP/IP pro-
tocol, see the "Setup Guide" that comes with the printer.

❖❖❖❖ Operating system browser requirements

Limitation

❒ Sometimes after clicking [Back] , the previous page may not appear. In this
case, click [Refresh] or [Reload] .

❒ The text on the screen may disappear or be aligned incorrectly if the font
size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

OS Browser

Windows 95/98/Me

Microsoft Internet Explorer 3.02/4.0/5.0

Netscape Navigator 3.0/4.0

Windows NT 4.0

Windows 2000

Mac OS 7.6.1 ∼ 9.0

Solaris 2.5 ∼ 2.7
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Going to the Top Page

After launching the Web Browser, type the IP address of the printer. See the ex-
ample below. This example is for the English version.

http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

Note

❒ If a DNS server is used on the network, you can type the host name as an URL.
For example, http://webmonitor.netprinter.com/. In order to do this, you
must the register the IP address and host name of the Network Interface
Board with the DNS server. Consult the network administrator for informa-
tion about how to do this.

❒ If the network uses proxy servers, the browser may run slowly.

1. Header Buttons

You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

Important

❒ It costs to use the browser to access
a website.

Note

❒ Help is stored on the CD-ROM in
HTML format.

2. Menu Buttons

Buttons to configure the Network Inter-
face Board and confirm the status of the
printer.

Note

❒ When you click [Configuration], a dia-
log box appears requesting the user
name and password. Type only the
password in this dialog box. The fac-
tory default password is “password”.

❒ The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status

Displays the name and comments of the
Network Interface Board, and the printer
status.

1

2

3
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----Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.

A Copy the Help files on the CD-ROM to the desired location. The Help files are
located in folders labeled with abbreviated language names. For example, En-
glish Help files are in the [EN] folder. Be sure to copy the entire [EN] folder to
the new location.

B Using a Web Browser, navigate to the Top Page and click [Network config].

C Type your password, (it is not necessary to type a user name) and click [OK].

D Type the path to the Help files in the [Help URL] box.
If you copied the Help files to "C:\HELP\EN", type "file://C:/HELP/". For
example if you copied the files to a web server and the index URL is "http://
a.b.c.d/HELP/EN/index.html", type "http://a.b.c.d/HELP/".

E Click [Apply].
When a warning message appears, select to continue configuration.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board using telnet.

Note

❒ You should specify a password so that only the network administrator, or a
person having network administrator privileges, can use remote maintenance. 

Using telnet

The following is a sample procedure in using telnet.

Limitation

❒ Only one person at a time can be logged on to do remote maintenance.

A Using the IP address or host name of the printer, start telnet.

% telnet IP_address

Note

❒ In order to use the host name instead of the IP address, you must write it
to the /etc/hosts file.

B Type the password.

Note

❒ The factory default is “password”.

C Type a command.

Reference

 For more information about telnet commands, see P.77 “Commands List”.

D Exit telnet.

msh> logout

When the configuration is changed, a confirmation message requests whether
or not the changes should be saved.

E Type “yes” to save the changes, and press the {{{{ENTER}}}} key.

If you do not want to save the changes, type “no”and press the {ENTER} key.
If you want to make additional changes, type “return” at the command line,
and press the {ENTER} key.

Note

❒ If the “Can not write NVRAM information” message appears, the changes
are not saved. Repeat the steps above.

❒ The Network Interface Board is reset automatically when the settings are changed.

❒ When the Network Interface Board is reset, the active print job which has
already been sent to the printer will finish printing. However, jobs that
have not been sent yet will be canceled.
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Commands List

This is a list of commands that can be used via remote maintenance.

Note

❒ Type “help” to see a list of commands that can be used.

msh> help

❒ Type “help command_name” to display information about the syntax of that
command.

msh> help command_name

TCP/IP address

Use the ifconfig command to configure TCP/IP for the printer (IP address, sub-
net mask, broadcast address, default gateway address).

❖❖❖❖ Reference
msh> ifconfig

❖❖❖❖ Configuration
msh> ifconfig nsf0 parameter address

The following is an example for configuring an IP address of 192.168.15.16.

msh> ifconfig nsf0 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0.

msh> ifconfig nsf0 netmask 255.255.255.0

Note

❒ This affects the configuration of the Network Interface Board of the IP ad-
dress that is used.

❒ To type an address using hexadecimal, prefix it by “0x”.

Parameter Meaning

(no parameter) IP address

netmask subnet mask

gateway default gateway address

broadcast broadcast address
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----Address

❖❖❖❖ Subnet Mask
A number used to mathematically “mask” or hide the IP address on the network by
eliminating those parts of the address that are alike for all the machines on the network.

❖❖❖❖ Default Gateway Address
A gateway is a connection or interchange point that connects two networks.
A gateway address is for the router or host computer used as a gateway.

Note

❒ To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control.

❖❖❖❖ Reference
msh> access

❖❖❖❖ Configuration
msh> access parameter address

Note

❒ The Access Control Address and the Access Control Mask are used to limit access
to the computer used for printing by denying access to users based on their IP ad-
dress. If it is not necessary to limit access, set the Access Control Mask to “0.0.0.0”.

❒ When the Access Control Address matches the masked result of the IP ad-
dress computer attempting to print, print jobs from that IP address will be ac-
cepted by the Network Interface Board.

❒ For example, if you assign 192.168.15.16 as the Access Control Address of the
Network Interface Board, the IP addresses that can print are as follows. XXX
means any number from 1 to 254 is acceptable.

Parameter Meaning

control Access Control Address

mask Access Control Mask

Access Control Mask IP addresses that can access the 
printer

  0.  0.  0.  0 XXX.XXX.XXX.XXX

255.  0.  0.  0 192.XXX.XXX.XXX

255.255.  0.  0 192.168.XXX.XXX

255.255.255.  0 192.168. 15.XXX

255.255.255.255 192.168. 15. 16
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Network Boot

Use the set command to configure the boot method.

msh> set parameter {on | off}

 “on” means active and “off” means inactive.

Note

❒ When you use DHCP, the server also needs to be configured.

❒ DHCP takes precedence over all other settings.

Protocol

Use the set command to allow/prevent remote access for each protocol.

msh> set protocol {up | down}

Note

❒ If you prohibit remote access using TCP/IP and then log out, you cannot use
remote access. If this was a mistake, you can use the printer operation panel
to allow access by TCP/IP.

❒ When you prevent access via TCP/IP, you are also prevented from using lpr,
ftp, rsh, diprint, web, snmp and ipp.

Parameter Meaning

dhcp DHCP (Dynamic Host Configuration 
Protocol)

Protocol

appletalk

tcpip

netware

netbeui

lpr

ftp

rsh

diprint

web

snmp

ipp

“up” means active and “down” means 
inactive.
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Printer status

The following commands can be used to get information about the current status
of the printer.

msh> command

Note

❒ More information about any print job is displayed when the ID number is
added after the prnlog command.

Reference

For more information about the meaning of the data returned with these com-
mands, see P.88 “Configuring the Network Interface Board”.

Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.

msh> show [-p]

Note

❒ Add “-p” to the show command to have the information displayed one screen
at a time.

Reference

For more information about the meaning of the data returned with this com-
mand, see P.88 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the printer's system
log. 

msh> syslog

Reference

For more information about the displayed information, see P.91 “System Log
Information”.

Command Information that is displayed

status Status of printer.

Information about the print jobs.

info Information about the paper tray, output tray, 
printer language of printer.

prnlog [ID] Lists the last 16 print jobs.
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SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

Note

❒ You can configure from ten SNMP access settings numbered 1–10.

❒ Default access settings 1 and 2 are as follows.

❖❖❖❖ Display
Shows the SNMP information and available protocols.

msh> snmp ?
msh> snmp [-p] [registered_number]

Note

❒ If the -p option is added, you can view the settings one by one.

❒ Omitting the number displays all access settings.

❖❖❖❖ Community name configuration
You can set the community name of the Network Interface Board.

msh> snmp number name community_name

Note

❒ The community name must consist of 15 characters or less.

❖❖❖❖ Access type configuration
You can select the access type from those listed below.
msh> snmp number type access_type

Number 1 2

Community name public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only

trap off

read-write

trap off

Access type Type of access which is permitted

read Read only

write Read and write

trap User is notified of trap messages.

no All access is denied.
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❖❖❖❖ Protocol configuration
You should use the following command to set the protocols to active or inac-
tive. If you set a protocol to inactive, all access settings set to use that protocol
are disabled.

msh> snmp {ip | ipx} {on | off}

•  “on” means active and “off” means inactive

To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.

msh> snmp number active {ip | ipx} {on | off}

❖❖❖❖ Access configuration
You can configure an address of a host depending on the protocols used. 
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.

Command syntax:
msh> snmp number {ip | ipx} address

Note

❒ To specify the TCP/IP protocol, type ip followed by a space and then the
IP address.

❒ To specify the IPX/SPX protocol, type ipx followed by a space and then the
IPX address followed by a decimal and then the MAC address of the Net-
work Interface Board.

The following is an example of how to configure registration number 3 with
the IP address 192.168.15.16.
msh> snmp 3 ip 192.168.15.16
The following is an example of how to configure registration number 3 with
the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.
msh> snmp 3 ipx 7390A448:000074625C65
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IPP

Use the ipp command to configure the IPP settings.

❖❖❖❖ Viewing setting
The following command displays the current IPP settings.

msh >ipp
Example output:

timeout=900(sec)
auth basic

• The "timeout" setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection
could be made.

• The "auth" setting indicates the user authorization mode.

❖❖❖❖ IPP timeout configuration 
Specify how many seconds to wait before canceling a print job if it has been
interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.

msh>ipp timeout {30 -65535}

❖❖❖❖ IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The
factory default is "off" .

ipp auth {basic|digest|off}

• "basic" and "digest" are user authorization setting.

• "off" removes a user's authorization.

Note

❒ If you select "basic" or "digest", see next section “Entry the IPP User Autho-
rization” for how to configure the user name. Up to ten user names are
available.

❖❖❖❖ Configuring IPP user authorization
Use the following command:

ipp user
The following message appears.

Input user number (1 to 10):
Type the number, user name and password.

IPP user name:user1
IPP password:*******
After configuring the settings, the following message appears.

User configuration changed.
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SMB

Use the smb command to configure or delete the computer name or workgroup
name for NetBEUI.

msh >smb parameter

ROUTE

Use the route command to control the routing table.

This command allows you to configure and display routing information. You
can change the network configuration from remote PC using this command.

Note

❒ The maximum number of routing tables are 16.

*1 IP address

Parameter Settings

smb comp Your computer name consisting of up to 13 characters

smb group Workgroup name consisting of up to 15 characters

smb comment Comment consisting of up to 31 characters

smb clear comp Clears complete name

smb clear group Clears Workgroup name

smb clear comment Clears comment

Parameter Topics of setting

route add {host | net} desti-
nation *1  gateway *1 

Adds a host/network route to "destination", and a gateway ad-
dress to "gateway" in the table. Host becomes the default setting.

route delete {host | net} 
destination *1 

Deletes a host/network route from the table. Host becomes the 
default setting.

route get {destination *1 } Displays only route information corresponding to a specified 
destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des-
tination *1  on/off

You can turn the specified destination on or off. Host becomes 
the default setting.

route flush Deletes all routing information.
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SLP

Use this command to configure SLP settings.

You can search the NetWare server using SLP in the PureIP environment of
NetWare5. To use the slp command, you can configure the value of TTL which
can be used by SLP multi-cast-packet.

Note

❒ The default value of TTL is "1". A search is executed only within a local seg-
ment. If the router does not support multi-cast, the settings are not available
even if the TTL value is increased.

❒ The acceptable TTL value is 1 - 255.

msh> slp ttl ttl_{1 -255}

Changing the password

Use the passwd command to change the remote maintenance password.

Important

❒ Be sure not to forget or lose the password.

Note

❒ The default factory password is “password”.

A Type “passwd”.

msh> passwd

B Type the current password.

Old password:

C Type the new password.

New password:

Note

❒ The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

❒ The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

D Type the new password once again.

Retype new password:
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SNMP

The Network Interface Board functions as a SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.

The factory default community names are “public” and “admin”. You can get
MIB information using these community names.

Reference

For more information about configuring the community name, see P.81 “SN-
MP” in “Remote Maintenance by telnet”.

Limitation

❒ The kinds of supported MIBs differ depending on the printer.

❖❖❖❖ Supported MIBs

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB
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Understanding the Displayed Information 

This section describes how to read status information returned by the Network
Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.

• telnet : Use the status command. ⇒ P.80 “Printer status”

Print Log Information

This is a record of the most recent ten jobs that have been printed.

This log can be displayed with the following commands.

• telnet : Use the prnlog command. ⇒ P.80 “Printer status”

Item name Meaning

Rank Status of print job.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is "0 bytes".

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Bytes The number of bytes that us received.

Request The request of the print request.

Time The time when the print request was received

User ID User id that is to be configured in the printer driver.

JobName The name of the document for printing.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed and confirmed using the
commands below.

• telnet : Use the show command. ⇒ P.80 “Network Interface Board configuration
settings information”

Item name Meaning

Common

Mode

Protocol Up/Down

AppleTalk

TCP/IP

NetWare

NetBEUI

Ethernet interface

NVRAM version

Device name

Comment

Location

Contact

Soft switch

 

 

Up means active, Down means inactive.

 

 

 

 

 

Internal version number.

AppleTalk

Mode

Net

Object

Type

Zone

 

AppleTalk protocol in selection.

Network number.

Macintosh printer name.

The type of printer.

Name of the zone that the printer belongs to.
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TCP/IP

Mode

ftp

lpr

rsh

diprint

web

telnet

download

snmp

ipp

EncapType

Network boot

Address

Netmask

Broadcast

Gateway

AccessCtrl

AccessMask

Time server

Home page URL

Home page link name

Help page URL

SNMP protocol

 

Up means active, Down means inactive. 

 

 

 

 

 

 

 

 

 

Frame type.

Network boot.

IP address.

Subnet mask.

Broadcast address.

Default gateway address.

Access control address.

Access control mask.

 

URL of homepage.

URL name of homepage.

URL of help page.

Protocol used with SNMP.

NetWare

EncapType

RPRINTER number

Print server name

File server name

Context name

Switch

Mode

NDS/Bindery

Packet negotiation

Print job timeout

 

Frame type.

Remote printer number.

Print server name.

Name of the connect file server.

Context of print server.

 

Active mode.

(this value is fixed)

 

Time of the job timeout.

Item name Meaning
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NetBEUI

Switch

Mode

Direct print

Notification

Workgroup name

Computer name

Comment

Share name[1]

 

 

(this value is fixed)

(this value is fixed)

Notification of print job completion.

Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

Shell mode Mode of remote maintenance tool.

Item name Meaning
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Message List

This is a list of messages written to the printer's system log. The system log can
be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.

• UNIX : Use the syslog paremeter of rsh, rcp or ftp command. ⇒“Printer Sta-
tus”in UNIX Supplement manual provided as a PDF file included on the CD-
ROM labeled Operating Instructions.

• telnet : Use the syslog command. ⇒ P.80 “System log information”

Message Description and Solutions

Access to NetWare server “file server name” 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect.

(In print server mode) Cannnot log in to the 
file server. Confirm that the print server is re-
sistered on the file server. If a password is 
specified for the print server, delete it.

add_sess: community<community name> al-
ready defined.

The same community name already exists. 
Use another community name.

add_sess: session<community name> not de-
fined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>, 
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_ipx: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_ipx: session_ipx<community name> 
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM <IP ad-
dress>, <password>

An anonymous login has been made with a 
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk) An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer=“file server name” Attached to the file server as a nearest server.

Attach to print queue “print queue name” (In print server mode) Attached to the print 
queue name.
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Cannot create service connection (In remote printer mode) Cannot establish a 
connection with the file server. The number of 
file server users may exceed the maximum 
number that the file server can handle.

Cannot find rprinter (“print server name”/
”printer number”)

The printer having the number displayed on 
the print server does not exist. Confirm the 
number of the printer registered to the print 
server.

Change IP address from DHCP Server. The IP address changes when DHCP LEASE is 
renewed. To always assign the same IP ad-
dress, set a static IP address  to the DHCP serv-
er.

child process exec error! (process name) Failed to start the network service. Turn the 
printer off and then on. If this does not work, 
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from 
the DHCP server.

connection from <IP address> Logged on from the host <IP address>.

Could not attach to FileServer<error number> (In remote printer mode) Cannot attach to the 
file server. For some reason, the file server re-
fuses the connection. Check the file server con-
figuration.

Could not attach to PServer<print server> (In remote pritner mode) Cannot attach to the 
print server. For some reason, the print server 
refuses the connection. Check the print server 
configuration.

Current Interface Speed:xxxMbps The speed of the network (10 Mbps or 100 
Mbps).

Current IP address <current IP address> The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address The current IPX address.

DHCP lease time expired. DHCP lease time has expired. The printer tries 
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCP server not found. The DHCP server cnnot be found. Make sure 
the DHCP server is running on the network.

dhcpcd start. A dhcpcd (DHCP client service) has started.

diprinted started Direct print service has started.

Duplicate IP=(IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address 
must be unique. Check the address of the de-
vice indicated in The same IP address is used. 
An IP address must be unique. Check the ad-
dress of the device indicated in <MAC ad-
dress>.

Message Description and Solutions
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Established SPX Connection with PServ-
er,(RPSocket=(socket number>), con-
nID=<connection ID>

(In remote printer mode) A connection with 
the print server has been established.

Exit pserver (In print server mode) Exits the print server 
because the necessary print server settings 
have not been made.

Frametype=“frame type name” The "frame type name" is configured to be 
used on NetWare.

httpd start. An httpd has started.

inetd start. An inetd has started.

ipp disable. Printing with ipp is disabled.

ipp enable Printing with ipp is enabled.

LeaseTime=<lease time>(sec), Renew-
Time=<renew time>(sec).

The resource lease time that was received from 
the DHCP server is in seconds. The renewal 
time is also in seconds.

Login to fileserver “file server name” 
(“NDS|BINDERY”) 

(In print server mode) Logged in to the file 
server with NDS or BINDERY mode.

multid start. Data transmission service for multiprotocols 
has started.

nbstart start. (NetBEUI) The service for NetWare protocol stack setting 
has started.

NBT Registration Broadcast(<NetBIOS 
name>)

Use a  local broadcast to map <NetBIOS 
name> with the IP address.

nptd start. A nbtd (NetBIOS over TCP/IP Daemon) has 
started. (Available only in DHCP mode)

NetBEUI Computer Name=“computer name” The NetBEUI Computer Name is defined as 
"computer name".

nmsd start. (NetBEUI) A nmsd (Name Server Daemon) has started.

npriter start. (NetWare) (In remote printer mode) NetWare service has 
started in remote printer mode.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file “file name” (In print server mode) The specified log file 
has been opened.

papd start. AppleTalk print service has started.

phy release file open failed. Replacing the Network Interface Board is re-
quired. Contact your sales or service represen-
tatives.

Print queue “print queue name” cannot be ser-
viced by printer 0, “print server name”

(In print server mode) The print queue name 
cannot be serviced. Make sure that print queue 
volume exists on the specified file server.

Message Description and Solutions
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Print server <print server name> has no print-
er.

(In print server mode) The printer object is not 
assigned to the print server <print server 
name>. Using NWAdmin, assign the printer 
object, and then restart the printer device. 

Print session full Cannot accept the print session.

Printer “printer name” has no queue (In print server mode) The print queue is not 
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then re-
start it.

pserver start. (NetWare) (In print server mode) NetWare service has 
started.

Required computer name (<Computer 
name>) is duplicated name

The same computer name is detected on the 
network. The start job determines the comput-
er name by adding the computer name to the 
suffix (0,1....). Configure a new computer 
name that is unique.

Required file server (“file server name”) not 
found

Cannot find the required file server.

restarted. LPD has started.

sap enable, saptype=<SAP type>, sap-
name=<sap name>

The SAP function has started. The SAP (SAP 
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name> A <NDS context name> has been set. 

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUI) An smbd (SMB (Server Message Block) ser-
vice) has started.

Snmp over ip is ready. Communication over TCP/IP with SNMP is 
available.

Snmp over ipx is ready. Communication over IPX with SNMP is avail-
able.

snmpd start. SNMP sevice has started.

The print server received error “error num-
ber” during attempt to log in to the net-
work.Access to the network was denied.Verify 
that the print server name and password are 
correct.

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without 
specifying a password.

Message Description and Solutions
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Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the printer.

Configuring the router

Filter the packets so that they do not pass over the dial up router.

Note

❒ The MAC address of the printer doing the filtering is printed on the printer
configuration page. For more information about printing a configuration
page, see the "Setup Guide" that comes with the printer.

❒ For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

A Following the setup method in this manual, configure the file server.

B Set the frame type for a NetWare environment.

Reference

For more information about selecting a frame type, see the "Setup Guide"
that comes with the printer.

Configuring the printer without NetWare

A While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

Reference

For more information about selecting a protocol, see the "Setup Guide" that
comes with the printer.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Operating Instruc-
tion Supplement provided as a PDF file on the CD-ROM labeled "Operating In-
structions".

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not print properly. If you want to change the form feed setting, al-
ways configure it on Windows.

• With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

• With Windows 2000, clear the [Form feed] check box on the [Neware Settings]
tab in the printer properties dialog box.

• With Windows NT 4.0, clear the [Form feed] check box on the [Neware Settings]
tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows. 

• With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

• With Windows 2000, clear the [Enable banner] check box on the [Neware Set-
tings] tab in the printer properties dialog box.

• With Windows NT 4.0, clear the [Enable banner] check box on the [Neware Set-
tings] tab in the printer properties dialog box.

Printing after resetting the printer

After resetting the remote printer, it will be cut off from the print server for about
30-40 seconds before connecting again. Due to the NetWare specification, print
jobs may be accepted, but they will not be printed during this interval.

When using the printer as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print. 
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When Using DHCP

Note the following points when using DHCP (Dynamic Host Configuration Pro-
tocol).

Supported systems

Windows NT Server 4.0 can be configured as a DHCP server.

Configure the printer with a reserved IP address

To always assign the same IP address, configure a reserved IP address using the
DHCP server.

Note

❒ When multiple DHCP servers are used, reserve the same address with each
DHCP server. The Network Interface Board needs to receive information
from the DHCP server that it contacts.

Follow these steps to configure the printer with a reserved IP address.

A Start the DHCP manager.

B Select the scope that will be used, and on the [Scope] menu, click [Reserva-
tion].

C Type the IP address into [IP Address].

D Type the MAC address of the Network Interface Board into [Unique Identifi-
er].

Note

❒ Do not use hyphens to separate the numbers.

❒ If you do not know the MAC address, it can be found on the configuration
page printed by the printer.

E Type a name and comment into the [Client Name] box and the [Client Comment]
box.

Note

❒ For more information about client names, see P.98 “Additional information”.

F Click [Add].

An IP address is reserved.

G Click [Close] to close the dialog box.
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Additional information

• When you click [Active Lease] on the [Scope] menu of DHCP manager, a list of
client leases appears. When the reserved IP address is not active, the name of
the reservation is the name entered in the Client Name field of the Add Re-
served Clients dialog box. When the reserved IP address becomes active, the
client name changes to the printer name configured by the Network Interface
Board. Only the first 13 letters of the printer name appear here. When you use
the printer with Multidirect Print, use the host name of the printer as the [Cli-
ent Properties] Client Properties dialog box.

• When the DHCP server does not assign an IP address, the Network Interface
Board uses 11.22.33.44 as a temporary IP address. You can confirm the print-
er's IP address on the network configuration page.

• Because 11.22.33.44 is a special IP address, you cannot print using this address.

• When using the DHCP relay agent in a network environment that uses a dial
up router to connect to the Network Interface Board, an increase in commu-
nication fees can occur.

When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, con-
firm that the TCP/IP environment is correctly configured in your computer.

When Using IPP with Multidirect Print

When using IPP with Multidirect Print, note the following:

• The network printer can only receive one print job from Multidirect Print at a
time. While the network printer is printing a job, another user cannot access
the network printer until it completes the job. In this case, Multidirect Print
tries to access the network printer until the retry interval expires.

• If Multidirect Print cannot access the network printer and times out, Multidi-
rect Print stops sending the print job. In this case, you should cancel the paused
status from the print queue window. Multidirect Print will resume access the
network printer. You can delete the print job from the print queue window, but
canceling a print job that has been printed by the network printer might cause
that the next print job sent from another user not to be printed correctly.

• If a print job that is sent from Multidirect Print is interrupted and the network
printer cancels the job because something went wrong, launch the print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

• If various users send print jobs using Multidirect Print to network printers,
the printing order might not be the order in which the jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the PortNavi port name.
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6

Specifications

LAN interface 100BASE-TX, 10BASE-T

Frame type EthernetII, IEEE802.2, IEEE802.3, SNAP

Protocol • TCP/IP
Windows 95
Windows 98
Windows 2000
Windows NT 4.0

• IPX/SPX
NetWare 3.12, 3.2, 4.1, 4.11, 5, IntranetWare

• NetBEUI
Windows 95
Windows 98
Windows 2000
Windows NT 4.0

• IPP
Windows 95
Windows 98
Windows 2000
Windows NT 4.0

• AppleTalk
Mac OS 7.6.1 or later

SNMP MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB
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access control address,   78
access control mask,   78
ARP+PING,   79

B

BOOTP,   79

C

client computer, setup
Windows 2000,   29
Windows 95/98/Me,   13
Windows NT 4.0,   46

community name,   81
configuration

LPR port printing, Windows NT 4.0,   45
Macintosh,   71
NetWare,   49
NetWare 3.x,   54
NetWare 4.x, 5,   60

Web Browser,   73
Windows 2000,   15
Windows 95/98/Me,   1
Windows NT 4.0,   31

D

default gateway address,   78
DHCP,   79, 97

dial up router,   95

E

EtherTalk,   71

I

information
Network Interface Board configuration,   

80, 88
print job,   87
print log,   87
system log,   80, 91

install
Multidirect Print, Windows 2000,   24
Multidirect Print, Windows 95/98/Me,   9
Multidirect Print, Windows NT 4.0,   41
NIB Setup Tool,   49
PortNavi, Windows 2000,   20
PortNavi, Windows 95/98/Me,   5
PortNavi, Windows NT 4.0,   37

IP address,   77
IPP,   83, 98

L

LAN adapter number (Lana Number),   34
LPR port Printing,   45

M

Macintosh,   71
message,   91

MIB,   86
Multidirect Print,   98

Windows 2000,   24
Windows 95/98/Me,   9
Windows NT 4.0,   41

Multidirect Print, install
Windows 2000,   24

Windows 95/98/Me,   9
Windows NT 4.0,   41

Multidirect Print, printer port
Windows 2000,   25
Windows 95/98/Me,   10
Windows NT 4.0,   42

Multidirect Print, uninstall
Windows 2000,   25

Windows 95/98/Me,   10
Windows NT 4.0,   42
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NetWare,   49
NetWare 3.x,   54
NetWare 4.x, 5,   60

network boot,   79
Network Interface Board Operating 

Instructions,   i
NIB Setup Tool,   51

install,   49
install, PRINTER MANAGER FOR 

ADMINISTRATOR,   49
precautions,   98

Run NIB Setup Tool,   50

P

password,   74, 85
PortNavi

Windows 2000,   19
Windows 95/98/Me,   4
Windows NT 4.0,   36

PortNavi, delete the port
Windows 2000,   21
Windows 95/98/Me,   6
Windows NT 4.0,   38

PortNavi, install
Windows 2000,   20
Windows 95/98/Me,   5
Windows NT 4.0,   37

PortNavi, printer port
Windows 2000,   22
Windows 95/98/Me,   7
Windows NT 4.0,   39

PortNavi, uninstall
Windows 2000,   21
Windows 95/98/Me,   6
Windows NT 4.0,   38

precautions,   95

printer name,   72
Printer Reference,   i
printer status,   80
Pure IP,   63

Q

Quick Installation Guide,   i

R

RARP+TFTP,   79
remote printer, setup

NetWare 3.x,   57
NetWare 4.x, 5,   65

S

setup
client computer, Windows 2000,   29

client computer, Windows 95/98/Me,   13
client computer, Windows NT 4.0,   46

Setup Guide,   i
SMB,   84
SNMP,   81, 86
specifications,   99

subnet mask,   78

T

telnet,   76

U

uninstall
Multidirect Print, Windows 2000,   25
Multidirect Print, Windows 95/98/Me,   10
Multidirect Print, Windows NT 4.0,   42
PortNavi, Windows 2000,   21
PortNavi, Windows 95/98/Me,   6
PortNavi, Windows NT 4.0,   38

W

Web Browser,   73
Windows 2000,   15
Windows 95/98/Me,   1
Windows NT 4.0,   31

Z

zone,   72
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Note to users in the United States of America

Notice:

This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

Consult the dealer or an experienced radio/TV technician for help.

Warning

Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution:

Properly shielded and grounded cables (STP) and connectors must be used for connections to host
computer (and/or peripheral) in order to meet FCC emission limits.

STP with ferrite core must be used for RF interference suppression.

Declaration of Conformity

Product Name: Network Interface Board

Model Number: Type 2600

Responsible party: Ricoh Corporation

Address: 5 Dedrick Place, West Caldwell, NJ 07006

Telephone number: 973-882-2000

This device complies with part 15 of FCC Rules.

Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and

2. this device must accept any interference received,

including interference that may cause undesired operation.

Note to users in Canada

Note:

This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Declaration of Conformity

“The Product complies with the requirements of the EMC Directive 89/336/EEC and the Low Voltage
Directive 73/23/EEC.”

Warning

Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Copyright © 2000
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